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1_ Introduction  

The BJOY Ring mouse emulator is a device which behaves like a 

conventional mouse and is specially designed to adapt to the controls 
of a wheelchair, using the inclination of the chair’s joystick to move 

the cursor and using the external switches to perform the normal 
functions associated to a mouse’s clicks. This device is aimed at users 

who use wheelchairs and who want to access the computer.  

The main features of the device are:  

• It is non-invasive and easy to install. 

• It can be adapted to the assembly position and to the user’s 

mobility by calibration.  

• Automatic recognition of the assembly inclination at the time of 
the connection. It can be installed in an inclined position (up to 

45º).  

• Compatible with all wheelchair models (the model must be 
chosen which is adapted to your wheelchair).  

• It has two customisable switches to perform the functions 

associated to the mouse clicks.  

• One of the switches allows for the cursor movement to be 
disconnected.  

• It does not require any installation software: the operating 

system recognises it directly. The configuration software which 
is supplied with the product allows the device to be calibrated 

so that its response is optimum.  

• Configurable and customisable using the BJOY configuration 

software which is supplied with the product.   

• The configuration is saved on the device and not on the PC 
which facilitates the use of the same device on different 

computers without having to reconfigure it. 

• The typical configurations can be done offered by the operating 
systems for the mouse (change of pointer type, click options, 

etc.).  
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2_ Description and assembly of the equipment 

2.1 Description of the equipment  

The BJOY Ring mouse is made up of the following parts: 
 

a) Ring 

b) Fixing screw 

c) Protection cover 

d) Switch input box 

e) USB connection 

f) Assembly spanner   

 

 

 

 

 

 

The joystick allows the cursor moving in all directions. The two 

configurable switches allows the click functions of the mouse to be 
performed: left click, right click, double click and drag-drop. The 

function of each switch can be assigned via the BJOY configuration 
software which is supplied with the product, selecting one of these 

Fig. 1 Parts of the BJOY Ring 

Fixing 

screw 

Ring 

Protection cover 

USB cable 

Switch input box 

Assembly spanner   
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functions for each switch input. See section 4.2 of the “BJOY 

configuration programme” in this user’s guide to obtain detailed 
information on the configuration.  

By default, the entry A performs the left click function and the entry 
B the right click function.  

2.2 Assembly of the equipment 

In order to assemble the equipment the following steps must be 
followed: 

1.  Take the handle off the 

wheelchair joystick and the 

protective hood if any.  

 

 

 

  



 

                                                                                                      

                                                                                                                
                                               

BJ-885 BJOY Ring                                                                                                                      

Page 5 

2. 2
. 

Insert the ring.  

 

 

 

 

 

The optimum position for 
assembling the ring is 

with the tightening screw 
in the chair’s forward 

direction. 

 

In the case that it can not 

be set up in the optimum 
position, it is VERY 

important that the ring is 
set up in positions with 
90º turns in relation to 

the chair’s forward 
position. 

 

If it is set up in different 
positions the mouse will 

not respond properly. 

 

 

 

 

 

3. 3
. 

Tighten the mounting screw using the spanner provided with the 

device. It is important not to force the tightening screw.  

 

Optimum 
position of the 

mounting 
screw 

osición 

óptima del 

tornillo de 

fijación 

Examples of 

assembly 

positions to 

avoid 

 

Other 

assembly 

positions of 

the mounting 
screw 
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4. 4
. 

Put on the protective hood. 

It is important to always 
put on the protective 

hood.  

 

 

 

 

 

5. 5 Reassemble the joystick 

handle onto the wheelchair. 

 

6.  Install the configuration 
software and do the 
calibration.  

See section 4.2.5 of the 
“BJOY configuration 

programme” in this manual. 
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In order to correctly assemble the equipment it is important to take 

into account the following indications:  

o Protect the switch input box from liquids. 

o Avoid water entering via the USB cable. 

o Use the USB extension lead if the cable does not reach directly.  

o It is recommended to use assemly inclinations of under 45º. 

 

3_How to use the BJOY Ring mouse 

In order to start using the BJOY Ring mouse the USB connection 

cable must be plugged into the computer’s USB port.  

IMPORTANT: In order to access the computer the wheelchair 
must be first disconnected. 

Although the device adapts to the assembly position, when it is 
connected to the computer’s USB port it must be calibrated in order 

to obtain the best response from the joystick’s movements. The 

following steps must be followed in order to perform the calibration:  

1) Install the provided BJOY configuration software.  

2) Do the calibration (See section 4.2.5 of the “BJOY configuration 
programme” in this manual). 

Once the calibration is done the device can be used like the joystick 

of the wheelchair. To move the cursor on the computer screen you 
just need to move the joystick in the desired direction.  

To avoid the cursor moving on the computer screen when you want 

to drive the wheelchair, you have to deactivate the mouse by closing 
the session on the computer, disconnecting the USB cable or 

configuring the “Deactivate” option using the configuration software 
(See section 4.2.4 of the “BJOY configuration programme” in this 

manual). 

If due to a slight change in the position of the joystick the mouse 
moves slightly without moving the lever, the device can be 

deactivated and then reconnected in order to recognise a new resting 
position. If this occurs frequently or the position of the wheelchair 

joystick is not stable, the “minimum inclination” value can be 
modified using the configuration software (See section 4.2.5 of the 

“BJOY configuration programme” in this manual). 

The two external switches which are connected to the entries 
indicated as A and B of the box for switch entries must be used to do 
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the clicks. By default these entries are assigned to the following 

functions:  

 

 

 

If only 1 switch is going to be used it can also be configured so that it 

does the deactivate function (See section 4.2.4 of the “BJOY 
configuration programme” section of this manual). 

This function can be configured using the BJOY configuration software 

(See section 4.2.2 of the “BJOY configuration programme” in this 
manual). 

For the correct use of this device, you are recommended to:  

 Do not use it in moving vehicles 

 Do a calibration if there is a substantial change to the 
wheelchair joystick’s resting position.  

 Do a calibration if irregular behaviour is noted.  

The functioning of the mouse can be customised using the 

configuration software (See section 4.2 of the “BJOY configuration 
programme” in this manual). 

  

Entry A: Left click 

Entry B: Right click 

B kept down: Deactivate BJOY Ring 
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4_ BJOY configuration software  

The BJOY configuration software allows you to configure the mouse 

behavior according to the user needs. 

 

4.1. Installation 

To install the program, you must follow these steps: 

 

1º Insert the CD included with the BJOY mouse in the CD-ROM drive 

of your computer or download the BJOYSetup.exe file from: 

 

http://www.bj-adaptaciones.com/en/products/bjoy-stick-a 

 

NOTE: If using the CD and your computer does not have CD-ROM, 

you can copy the CD contents on a USB stick or any other 

removable drive. 

 

2º If using the CD the installation should begin automatically. If it 

does not, browse to the CD or removable drive and click on 

BJOYSetup.exe file. If using the web page, go to section 

“Downloads” and click on “BJOY Software”. Save the 

BJOYSetup.exe file in your computer and double click to start 

installation. 

 

3º When the installation begins the wizard will guide you through the 

process. It is recommended to close all other programs during the 

process. You must click "Next" to continue. 

 

4º You can choose a different path for the installation file and create 

a shortcut to the program in the Start Menu and Desktop.  

 

5º Once you have selected your installation preferences, click 

"Install" to install the program on your computer. 

 

6º Once installation is completed, click "Finish" to exit. 

 

 

 

http://www.bj-adaptaciones.com/en/products/bjoy-stick-a
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4.2. Configuration 

IMPORTANT: Once the software is installed in your computer, in order 

to access to the multiple settings options you must have a BJOY 

device connected to your computer. 

 

In case you do not have any BJOY device connected, the following 

screen will appear: 

 

 

 

IMPORTANT: if you want that the settings are applied to the BJOY 

device, click on the "Apply" button that appears at the right bottom of 

the window. 

 

The instructions for using the BJOY Software are available 

from the “Help” menu:  
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4.2.4. Shutdown 

In the event that you want to configure the deactivate/activate option 

of the BJOY Ring mouse, select the “Shutdown” tab. This 

configuration allows you to deactivate the movement of the cursor 
while you are moving the wheelchair.  

Select from the “Shutdown switch” drop-down list the entry which 
you want to deactivate the device with. 

If you have selected entry A or B, you can adjust the necessary time 

that the corresponding entry has to be activated so that the device is 
activated/deactivated. Select the desire time from the bar: 

“Shutdown accept time”.  

 

4.2.5. Calibration 
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You must do a calibration whenever there is a change in the 

assembly position of the BJOY Ring or improper behaviour is noted. 
In this case select the “Calibration” tab. 

 

 

In order to calibrate the BJOY activate the “Start” button and follow 

the steps indicated in the screen.  

In the event that small movements in the wheelchair’s joystick cause 

undesired cursor movements, you can eliminate them by increasing 
the “Minimum inclination” value. The higher this value, the more the 

joystick will have to be inclined in order for the cursor to move. 

 

 

 

 

4.3 Save a customize setting 
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To save a setting after making any customization, follow these steps: 

1. Select the “File” menu 

2. Select "Save Settings" 

3. In the next screen, assign a name and a location to save the 

file. Accept making click on the "Save" button. 

 

 

4.4 Loading a configuration 

To reload a saved configuration in order to modify it or save it in the 

device, follow these steps: 

1. Activate the “File” menu 

2. Select "Load settings" 

3. Find the file corresponding to the stored configuration (files are 
saved with the extension ". BJOY."  Click on the "Open" button 

in the same screen. 

To load the configuration on the device you must click on the "Apply" 
button. 

 

4.5 Language settings 

To change the language of the program, just follow these steps: 

1. Activate the “Tools” menu. 

2. Select "Change language" 

3. Choose your preferred language and validate clicking the 

"Accept" button. 

 

 

 

 

5_ Maintenance of the equipment 
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When maintaining and cleaning the equipment take into account the 

following precautionary measures:  
 

o Do not connect the equipment to any other type of connections 
other than USB ports. 

o To connect and disconnect the cable always hold it by its 

connector. Do not directly pull the cable.  

o Do not bend or force the end of the cable.  

o To clean the device use a moist cloth. Do not use abrasive 
substances. Always clean the device when it is disconnected.  

o Avoid liquids entering into the switch box as this could seriously 
damage the equipment. 

o The equipment is not designed to be used outdoors. 

o Do not manipulate the device in the event of a fault. 

 

6_ Technical characteristics 

o USB 2.0 connection 

o Operating voltage: 5 V. 

o Operating current: 70 mA 

o Ring disk diameter: 35 mm 

o Size of the switch box: 50 x 25 x 13 mm 

o Size of the ring’s axis: 3/16” (4.75 mm) and ¼”(6.35 mm) 

depending on the model. 

o Length of the ring cable: 50 cm. 

o Length of the USB cable: 1 m. 

o Switch input: 2 entries for 3.5 mm jack 

o This product complies with the European directives 
2004/108/EC. The declaration of conformity can be consulted at 

the webpage included in this manual. 
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7_ Disposal of the product 

 At the end of the product’s useful life neither the product nor its 

electronic accessories (e.g. the USB cable) can be eliminated 

together with other domestic waste.  

 To avoid possible environmental or human harm which could be 

caused by uncontrolled waste disposal, separate these products 

from other types of waste and correctly recycle them. This will 

promote the sustainable reuse of material resources.  

 Consumers can contact the establishment where they 

purchased the product or the relevant local authorities in order 

to obtain more information about how and where they can be 

ecologically and safely recycled.  

 



 

                                                                                                      

                                                                                                                
                                               

 

 

 

 

 

 

 

 

 

 

 

 


